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Addendum

Hotkeys
Hotkeys have been extensively overhauled. Multiple hotkeys panels may now be 

open simultaneously, each to a different page of hotkey cells. Remote access to hotkeys 
and all hotkey functions allows producer/talent teams to work together from different 
computers, one prepping and loading hotkeys, the other playing them to air. Hotkeys 
may now be looped and paused. A hotkey cell may be unloaded (cleared of audio), 
leaving other settings in place. A new Settings/Hotkeys dialog provides controls for 
customizing hotkey layout and performance, and for setting default values for attributes 
like fade-out time, pad and mono-mix.  

Hotkeys windows may be opened from the View menu, or by right-clicking the 
Hotkeys button (bonfire icon) to the lower left of the waveform editor. Hotkey windows 
may be dragged to a secondary display monitor. All hotkey tab pages are accessible 
from all hotkeys windows.

Administrator may restrict which audio playback devices are allowed to be displayed 
in a hotkey cell’s Playback Device dropdown menu, and may provide optional labels 
for those devices which do appear in the menu. These controls are accessible from 
the Audio Devices and Formats dialog, in the Settings menu.

Shortcuts
Users may now assign a variety of functions, effects and their own FX Macros to 

the five hot keys on the VP control panel (the buttons which are normally used to trig-
ger audio Hotkeys). These functions are accessed by pressing the Control, Option and 
Shift buttons on the controller, in conjunction with the hot key. Users may optionally 
elect to display any bank of shortcuts permanently, making these functions accessible 
at all times with a simple press of the corresponding hot key. 

Default File Names
In order to accommodate file naming conventions imposed by various automation 

systems, users now have more control over the format of default file names. (The 
default name is the name which is automatically given to a newly recorded file, like 
“Untitled_32”, or “Phone67” or “COM0138”.) Any “root” name may be used, and leading 
zeros may now be specified. Optionally, file names may be numerical only, e.g. “0016”.

What’s New In VoxPro7.1
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Miscellaneous
VoxPro now waits for Auto-Import files to stop growing in size before importing. Auto-

imported files may now be automatically gain adjusted or normalized during the import 
process.

The headroom display setting (in Settings/Playback) is now incorporated into the 
zoom controls in the right margin of waveform editor.

A new command allows the Administrator to rebuild all users’ file databases.

It is no longer necessary to install the WNIP PC Driver in order to use WNIP routing 
commands. Users’ routing preset settings are now restored at login. Non-intersecting 
routes may be toggled on/off.

It is no longer necessary to install the Sentinel HASP driver if the Keylok dongle is 
being used. An improved installer allows the HASP driver to be uninstalled if not needed.

The peak volume meters are now hidden when the Waveform Editor is hidden.

The QuickSearch panel now remains at upper right corner of the File List at all times.
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   			      	  Introduction 

VoxPro 7.1 is used for recording, editing, playing, sharing and managing audio files, 
particularly in broadcast contexts where two-channel (stereo) recording is the norm.  
A robust file storage system allows files to be stored anywhere on the LAN, accessed 
from any VoxPro computer on the LAN, and shared with any VoxPro user on the 
LAN. Users may keep files around for years and still access them easily at any time 
for immediate playback or further editing. The optional hardware control panel gives 
experienced users a powerful tool for making lightning-quick edits in real-time situations 
where every second counts. 

If during  installation or setup you find that you need assistance or advice,  please 
feel free to contact our technical support engineers at (252) 638-7000 or email us at:  
techsupport@wheatstone.com.

VoxPro 7.1 Software and Control Panel come with a one year warranty.

VoxPro 7.1
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Chapter 1. Overview of Main Window Controls

Figure 1.1 shows the main VoxPro7.1 window in “classic” mode, with the waveform editor 
filling most of the upper half, and the file list in the lower half. In this particular case, a short 
region of the file in the middle of the display has been selected for editing, and is therefore 
highlighted with a pale yellow waveform on a light gray background.

Figure 1.1 – Main VoxPro7.1 window in Classic mode.

Let’s now take a closer look at the various controls.  
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On the left side of the window (Figure 1.2), we see the length of the selected region in 
the Editor (1.95 seconds), we see that mono-mix playback is enabled, and that Hotkeys, 
Multitrack and Master mode are all toggled off. We also see that we are in Standby mode 
(the other possibilities being Playing, Recording or Scrubbing); and in two places we see 
the name of the file loaded in the Editor: in the title bar at the very top of the window, and 
as a selected item in the File List.

Figure 1.2 – Main window controls, left side.
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On the right side of the window (Figure 1.3), we see a status display in the top right 
corner. If nothing else is going on, it simply gives us a count of the files in the current folder. 
If importing or exporting a file, this display informs us of the progress of that operation, 
as well as any errors encountered. Immediately beneath the status display is an indicator 
telling us how much total disk space on the current volume is available for new recordings, 
file imports, etc. Zoom controls in the right margin of the waveform Editor are useful for 
seeing low-level signals better. The classic mode button returns us to this particular layout 
(2-track editor above, file list below) from any other window arrangement, and we see 
that it is engaged. Controls for background editing and recording are located next to the 
classic mode toggle, and are discussed later in this manual.

Finally, at the top of the window to the left of the status display, we see four routing 
controls defined (from a total of eight). These are available only when a WheatNet AOIP 
driver (WDM/DirectSound version) has been installed on the computer. They are usually 
used to select from different sources for recording, but can, in fact, reconnect any source 
to any destination within a WheatNet‑IP network, and can also be used to fire Salvos. 
See the Wheatnet‑IP BLADE3 Audio Over IP Network manual for further information.

Figure 1.3 – Main window controls, right side.
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Taking a closer look at the area around the waveform editor (Figure 1.4), we see 
a Timeline tracker immediately above the editable area of the waveform display. The 
Timeline represents the time span of the file which is in the Editor from beginning to end 
– it is thus a relative scale. It contains a current position indicator (the inverted white 
triangle) as well as any position Markers that might have been inserted (more on these 
later). You may click with the mouse on the current position indicator and drag it left or 
right to relocate your position within the file. Conversely, you may click any place within 
the Timeline to jump immediately to that relative location within the file.

The vertical red cue line in the middle of the waveform Editor represents the current 
play position within the file. Beneath it and to either side are two clocks. The one on the 
left displays the current file position, while the one on the right displays the time remain-
ing to the end of the file. 

Figure 1.4 – Area surrounding middle portion of waveform Editor.
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Chapter 2. Basic Operations

Most editing, playback, scrubbing and recording commands are available on the 
VoxPro 7.1 hardware control panel as well as the computer keyboard. The mouse and 
main menu also provide access to many operations. Basic editing and transport com‑
mands are described below. Detailed lists of all control panel and keyboard commands 
can be found in the Appendix.

Playing
There are three flavors of playback: Play from Beginning, Play Selection, and Play 

from Current Position. Each of these functions is assigned to a dedicated button on 
the control panel. On the keyboard, the P, S and <spacebar> keys perform the same 
functions, respectively. While a file is playing, it can be stopped with either the PLAY 
button or STOP button on the control panel, or the <spacebar> key on the keyboard.  

The Playback Options dialog box, accessible from the main Settings menu, allows 
you to customize a number of features related to playback. You may enable mono‑mix 
playback as the default setting. (Your default setting may be overridden at any time using 
the mono‑mix button in the left margin of the Editor.) You may hide the mono-mix button 
in the Editor, thus removing the ability to override the default setting. Playback direction 
refers to which way the scrolling waveform in the Editor moves as the file plays, right‑to‑left 
being the default. Display headroom is a cosmetic visual setting which affects the scale 
along the vertical axis of the waveform displayed in the Editor. The effect is to zoom in 
on the vertical axis as the headroom value is increased. [Now the technical explana‑
tion:  the headroom value represents the potential dynamic range available above the 
top edge of (each channel of) the waveform display. A headroom value of 6dB means 
that a signal which peaks at the top edge of the waveform display is still 6dB away from 
saturation or clipping. By default, the full dynamic range is displayed, with the top of the 
display at 0dB full scale.]
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Scrubbing
Scrubbing is the process of moving through a file, either to log what is there, or in 

search of the precise location to perform an edit. In the center of the control panel is an 
array of six buttons used for scrubbing at different speeds. The top pair is fast forward/
reverse, the middle pair is normal forward/reverse, and the lower pair is slow forward/
reverse. These buttons may be held down in combination to toggle between speed and 
direction. For example, you might be holding the fast rewind button to locate a position, 
and pressing the normal speed forward button at various points in order to momentarily 
hear normal playback.

To the left and right of the fast forward/rewind buttons on the control panel are the 
GoToBeginning and GoToEnd buttons. And finally the jog wheel on the right side of the 
control panel can be used across a range of speeds to move quickly or slowly through 
the file in either direction.

On the keyboard, the <left-arrow> and <right-arrow> keys perform the basic 
fast‑forward and fast‑rewind functions. They can be used in combination with the <shift> 
key for normal playback, and with the <ctrl> key for slow playback.

Holding down the <ctrl> key on the keyboard, click and drag the mouse right or left 
within the waveform view to scroll the waveform itself by the same amount.

Scrub behavior in VoxPro7.1 may be customized to each user’s preference. Open 
the Scrub Settings dialog box from the Settings menu. At the very top is an option 
which makes fast forward/reverse always audible (at 3x normal speed) for as long as 
one of these functions is engaged (or until you reach the beginning or end of the file). If 
the always audible option is not enabled, then you have an option for a two‑stage scrub, 
in which fast forward/reverse is audible at the beginning (at 3x normal speed), and 
then jumps after a specified length of time to a much faster speed which simply scrolls 
through the file without audio playback. Finally, the speed of the non-audible phase of 
the scrub function may be specified by adjusting the fast forward/reverse speed control.

The Scrub Settings dialog box also lets you invert the combination of <ctrl> key and 
mouse click‑drag in the waveform, giving you the option to scroll through the waveform 
using the mouse without requiring that the <ctrl> key be held down. 

Recording
Press the Record button on the control panel, or R on the keyboard, to start 

recording. This operation always creates a new file; it never overwrites an existing file. 
To stop recording, press the RECORD or STOP buttons on the control panel, or the R or 
<spacebar> keys on the keyboard. At this point a dialog box will appear allowing you to 
name the new file (or accept the generic name) and save it, or cancel it (which just puts 
it in the Deleted Files folder). From the control panel, the OKAY and CANCEL buttons 
perform these functions. On the keyboard, the <enter> and <esc> keys do the same. 
Note that you can cancel a recording at any time by using the CANCEL button or <esc> 
key, in which case the file is closed and moved to the Deleted Files folder immediately.

Insert-Recording
Insert‑record is a specialized function allowing you to insert new audio content into an 

existing file, sliding the remainder of the file back from the insertion point.  (The existing 
content is not overwritten, it is only moved back by the length of the new content.) Insert-
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recording commences from the cue line, and can be started while playing, scrubbing, or 
stopped. To start, press the INSERT‑RECORD button on the control panel, or the I key 
on the keyboard. To stop, press the INSERT‑RECORD or STOP buttons on the control 
panel, or the I, <spacebar> or <enter> keys on the keyboard. An Insert‑Record may 
be cancelled using the CANCEL button on the control panel, or the <esc> key on the 
keyboard. A cancelled Insert‑Record cannot be recovered. 

Background Recording
In certain cases, you might need to start recording while VoxPro7.1 is already en‑

gaged in file playback, or you might want to access a recording while it’s in progress (for 
example, a long sporting event) in order to extract highlights for immediate broadcast, 
sharing, uploading, etc. In both of these cases, you will be playing and editing in the 
foreground, while simultaneously recording in the background.

While VoxPro7.1 is playing a file, you may start a recording 
in the background by pressing the BG REC button in the lower 
right corner of the Editor pane. Now you may continue playback, 
stop and play other files, fire off Hotkeys, scrub, edit, import 
and export files; all while VoxPro7.1 continues recording in 
the background. The only operations you may not perform are 
Record and Insert‑Record (because you’re already recording).

While VoxPro7.1 is recording a file (in the foreground), you 
may put the recording process in the background by pressing the 
BG REC button. The file currently being recorded is displayed 
in the Editor (now in “playback green”), rolled back 10 seconds 
from the point where the recording was backgrounded, and the 
EDIT BG button is lit.

As long as the BG REC button is lit (red), it means you have 
a recording running in the background. When the EDIT BG 
button is lit (green), it means that the file displayed in the Editor 
is the file which is currently being recorded (in the background). 
As such, you cannot actually edit the file – because it is still be‑
ing written to the disk! However, you may place Markers (see 
Chapter 6) in the file at any location, and you may copy any 
portion of the file into a different file or a brand new file (using 
copy/paste or the New Edit from Selection command), which you may then edit and 
export as you wish. All the while, recording continues uninterrupted in the background.

If you select another file in the File List, that file is loaded into the Editor for playback 
and editing, turning off the EDIT BG button. Click the EDIT BG button again to re-load 
the file being recorded in the background.

A background recording cannot be stopped until it is returned to the foreground, where 
it becomes a normal recording which can be stopped and named in the normal manner.  
Click the BG REC button while a background recording is in process to bring it into the 
foreground, displaying the incoming signal in the Editor in the usual “recording red” color. 
Stop and name the file at this point if desired, or put it in the background once again by 
clicking the BG REC button.
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Additional Record Options

Default File Names
When you make a new recording, the file starts its life with a generic name, some‑

thing like “Untitled52.” Of course you have the option to name the file anything you like, 
but some users might actually want to use a generic name of some sort. For example, 
many automation systems use the file name as a means of classifying the audio type 
and assigning an asset number. For this purpose, VoxPro lets you control the rules used 
to generate the generic name given to a file when it is first created. These rules and a 
few other options are available in the Record Options dialog box, which is accessible 
from the Settings menu.

At the top of this dialog you set up the rules for creating a generic, default name for 
files. The root file name can be something like “Phone” or “PHO” or “COM”. After the 
name, digits will be added in numerical order. You may choose to pad the digits with 
leading zeros, for example “Phoner0019” rather than “Phoner19.” Optionally, you may 
have an underscore between the name and the digits (“Phoner_0019”), or not use the 
name at all, so that it is compose only of digits (“00019”).

Automatic Gain Control
If your VoxPro 7.1 administrator has configured and enabled Automatic Gain Control, 

then you may disable or enable that process when recording in your own account using 
the Enable AGC switch.

Auto-Record
Auto‑Record is a feature designed for fast call‑in contests, when you want every caller 

in a separate recording, but you don’t have time to name each one. Enable Auto‑Record 
at the very top of the Settings menu. Now each time you start press RECORD (or R 
on the keyboard) the current recording is stopped, given the default name, and a new 
recording is started, creating an automatic “chain” of recordings, all of which appear 
as separate files in the File List. To stop Auto‑Record, press STOP (or <spacebar> 
on the keyboard) at the end of your last call. The record function returns to its normal 
operational mode, so you’ll need to re-enable Auto‑Record if you want to start another 
chain of recordings. You may keep Auto-Record enabled at all times by unchecking 
the Disable after stopping option in the Record Options dialog in the Settings menu.
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Chapter 3. Editing
In VoxPro 7.1, editing operations are applied to the selected region of the active file 

displayed in the Editor, meaning that if nothing is selected, then you have nothing to 
edit. This goes as well for the effects listed in the Effects menu, most of which are really 
just various kinds of specialty edits. The selected region may be of any size, up to and 
including the entire file. (The Insert Silence effect and the Paste function are the only 
edit operations which do not require a prior selection, since both are applied regardless 
of length at the location of the cue line.).

Selection
To select a region, use scrub controls to position the waveform so that the left or 

right boundary of the desired region is positioned at the cue line. Press the MARK LEFT 
or MARK RIGHT buttons on the control panel, or the [ and ] (square‑bracket) keys on 
the keyboard. Reposition the waveform so that the opposite boundary is at the cue line, 
and place the opposite mark. Conversely, you may use the mouse to click‑drag in the 
waveform Editor directly. The selected region is highlighted by displaying the waveform 
in pale yellow over a light gray background, and the length of the selected region is dis‑
played in the indicator in the top left corner of the Editor. Note that you may adjust the 
left or right boundary of the selected region by relocating the waveform relative to the 
cue line and reapplying the left or right mark, as appropriate. Using the mouse, you may 
right‑click within the waveform to change the location of the closest boundary of the 
selected region to the location of the mouse cursor.

You may play the selected region using the PLAY SELECTION button on the control 
panel or the S key on the keyboard.

The selected region may comprise the entire file. To select the entire file from the 
control panel, apply Mark Left at the beginning of the file, and Mark Right at the end. 
From the keyboard, simply type <ctrl>A, or select the Select All command in the Edit 
menu.

You may create an entirely new file from the selected region using the New Edit from 
Selection command in the File menu.

The currently selected region may be deselected by pressing the DESELECT button 
on the control panel, the K key on the keyboard, or by using the Deselect command in 
the Edit menu.

Note that you can click the mouse within the waveform to initiate selection, and then 
drag it beyond the left/right margins of the Editor to continue selecting and scrolling in 
that direction. Press and release the PLAY button while scrolling to hear where you are 
while continuing to extend the selection region.

There are two additional options which modify selection behavior, both of which are 
available in the Selection Options dialog in the Settings menu. The first options causes 
playback to stop if you are playing a clip when you place a left mark or right mark. (The 
default behavior is to continue playing the clip when left or right mark is inserted.) The 
second option is a shortcut which automatically places a left mark at the beginning of 
the file if a right mark is inserted by itself without a pre-existing left mark (thus selecting 
back to the beginning). This behavior is disabled by default.
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Basic Edits
The selected region may be deleted by pressing the DELETE button on the control 

panel, or the <del> key on the keyboard.

The selected region may be copied (to the clipboard for later pasting) by pressing 
the COPY button on the control panel or the C key on the keyboard.

The cut operation is a combination of Copy and Delete. It first copies the selected 
region to the clipboard, then deletes it from the current edit. Press the CUT button on 
the control panel, or the X key on the keyboard.

As long as a region has been copied into the clipboard (using either the Copy or Cut 
functions), then you may paste that region into any file, including the one it came from.  
The paste function is always applied at the current location in the file, that is, at the cue 
line.  From the control panel, press the PASTE button, or the V key on the keyboard.

Undo/Redo
Whether applying basic edits or complex effects, all changes may be taken back by 

pressing the UNDO button on the control panel, or the Z key on the keyboard. The Undo 
function is effectively infinite – you can continue to undo your changes (in reverse order) 
all the way back to the original state when the file was first recorded or imported. (It is 
not possible to undo an early edit without also undoing every edit back to that point.) 

You may Redo any Undo or sequence of Undos, returning the file back to state of 
your most recent edit. From the control panel, hold down the OPTION button and press 
UNDO, or from the keyboard with the Y key.  

Master Mode provides a quick shortcut to get back to the original audio data in the 
file, ignoring all edits, undos and redos, and providing access to all audio data in file, 
including anything pasted in from another file, insert-recorded, or processed through the 
Pitch /Time effect or one of the Advanced Signal Processing effects. Click the MASTER 
button in the lower left corner of the Editor to toggle Master mode on and off.  (Some older 
models of the control panel also have an EDIT/MASTER button which does the same 
thing.) While in Master mode, you may not perform any edits or apply any effects, but 
you may select and copy any region for pasting either into the same file (when toggled 
back out of Master mode), or into another file.

Zoom
Press the ZOOM button on the control panel (or the Q key on the keyboard – think 

“magnifying glass”) to toggle between 1x, 4x, and 10x zoom along the horizontal (time) 
axis in the waveform Editor. For maximum zoom at the sample level, press both the 
CONTROL and ZOOM buttons on the control panel, or type <ctrl>Q from the keyboard. 
Selecting another file automatically resets Zoom to 1x.
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Chapter 4. Effects
We use the term “effects” somewhat loosely. Some of the functions in the Effects 

menu – for example VoiceSlip™, Insert Silence, or GapBuster – are really nothing 
more than specialized editing operations. Other functions, like flanging, echo and reverb, 
are true special effects which change the character of the sound. The ClipCleaner ef-
fect is actually a full suite of signal processing functions including a de-esser, 6-band 
parametric EQ, and dynamics processor (compressor, expander, limiter, noise gate). 
All of these with the exception of Insert Silence require a selected region in order to 
be applied. Although the effects are listed in the menu in alphabetical order, let’s group 
them by function instead and take a closer look.

Mute, Fade, Normalize, and Adjust Volume

Effects Which Change Volume
Four of the effects can be used to apply volume changes. Probably the most com-

monly used of these is Mute, which is usually applied to one of the channels, rather than 
both simultaneously. The mute effect is most commonly used for editing phone calls, 
where you want to delete only the caller or only the jock within the selected region. This 
use of mute is so common that there is a shortcut for it built into the control panel: hold 
the CONTROL button down (this is one of the four buttons in the top left corner of the 
control panel), displaying five Effects in the LCD above the hotkeys. The first two hotkeys 
may be pressed to mute the left or right channel, respectively.

The Adjust Volume effect opens a dialog box which is used to adjust the volume of 
the selected region up or down by 30dB. The volume adjustment will be applied equally 
to both channels if the link button between the left and right trackbars is enabled; other-
wise each channel may be adjusted independently.

The Fade effect may be used to fade the selected region either up or down. The effect 
may be applied to both channels simultaneously, or to only one. A cross‑fade effect can 
be achieved by applying Fade‑In to one channel and Fade‑Out to the other over the 
same selection region.

The Normalize effect is used to bring the volume of one or both channels to a 
pre-determined maximum level. It is most commonly applied over the span of the entire 
file (either to one channel or to both). The keyboard shortcut <ctrl>O applies your most 
recent normalization setting to the selected region.

Bleep and Reverse

Effects Which Mask Content
Two of the effects are used to mask content (for example, words or lyrics which may 

not be broadcast over the airwaves). Bleep is the most commonly used of these, and 
has two shortcuts. From the control panel, hold the CONTROL button down, displaying 
five effects in the LCD, then press the middle hotkey to apply Bleep to both channels. 
From the keyboard, simply type the B key.

The Reverse effect is a more subtle effect than Bleep. It simply reverses the audio 
waveform in the selected region, in either channel or both. It is often used in musical 
contexts since it can obfuscate a particular word without changing the pitch or interjecting 
a 1kHz sine tone.
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VoiceSlip, BackSlip, and Channel Paste

Effects Which Change the Temporal Order of Events
Three effects allow you to manipulate the original temporal relationship between 

the left and right channels; that is, to move one of the channels independently of the 
other.  The most common of these is VoiceSlip, which solves the problem of host/caller 
talk‑over by sliding one of the channels past the other. Figure 4.1 shows a selected 
region in which the caller (left channel) and host talk over each other.

￼ Figure 4.1 – Selected region highlighting host/caller talk-over.

VoiceSlip may be used to slide the left channel behind the right, or the right chan-
nel behind the left. In this case, we choose the “right before left” option, resulting in the 
altered version shown in Figure 4.2.  

￼ Figure 4.2 – After applying VoiceSlip to host/caller talk-over.

The VoiceSlip effect is also available as a control panel shortcut. After selecting 
the region where you want to apply VoiceSlip, press and hold the CONTROL button to 
display the five effects shortcuts in the control panel LCD. The two right-most hotkeys 
apply VoiceSlip: Left before Right and Right before Left.
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The BackSlip effect is the opposite of VoiceSlip. It creates talk‑over where it did 
not originally exist.  (Your witty comeback can come sooner.) Consider the example in 
Figure 4.3.  The region encompassing the area in question has been selected:

￼ Figure 4.3 – Selected region highlighting the area where BackSlip is desired.

BackSlip can slide the left channel back past the right, or the right channel back past 
the left. In Figure 4.4, we choose to slide the right channel back:

￼ Figure 4.4 – Choosing which channel to slide back.

After applying the effect, the host (right channel) sounds like he interjects his com-
ment even before the caller has finished speaking, as seen in Figure 4.5:￼

Figure 4.5 – Creation of host/caller talk-over after applying BackSlip effect.
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Finally, the Channel Paste effect can be used to copy a single channel of audio from 
a given region, then paste it – into the same channel or into the opposite channel – at 
another location within the same file. In Figure 4.6, a music tag at the end of a file has 
been selected as the source. Note that both channels are selected, even though we will 
be copying and pasting just one of them.

Figure 4.6 – Selected region to be used in Channel Paste operation.

We now relocate the file to the desired insertion point at the cue line, and select the 
desired paste operation (Figure 4.7). In this case, we will paste the content from the left 
channel of the source into the right channel of the destination.

Figure 4.7 – Choosing the Channel Paste operation to be applied at the cue line.

After applying the operation, we see the original left channel of the source is now in 
the right channel of the destination, Figure 4.8:

Figure 4.8 – After applying Channel Paste at cue line. Note left channel remains unchanged.
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Silence Removal (GapBuster) and Pitch/Time Manipulation
Special Purpose Effects

The GapBuster effect is used to automatically remove gaps (silences) in a conver-
sation or interview, saving you the time and effort editing them out manually. The dialog 
box allows you to define what constitutes a “gap”. By default, it is a span of time at least 
a quarter of a second in duration during which the signal never exceeds a certain volume 
level called the silence threshold. You may adjust these values to your own style and 
ambient noise conditions of the recording. A smaller gap (say 100ms) will sound tighter, 
while a longer gap (500ms) allows quite a lot of breathing room. A silence threshold 
too high will clip off parts of words, while a threshold too low will not remove pauses 
in conversation which contain significant background noise. If the auto-detect option is 
selected, VoxPro will try to determine the optimal silence threshold automatically.

There are two keyboard shortcuts for GapBuster. The <ctrl>+G combination is 
equivalent to selecting GapBuster from the effects menu: it opens the dialog box which 
allows you to adjust the gap length and threshold. You may also simply type G alone to 
apply the most recently used GapBuster settings to the selected region.

The Pitch and Time effect can be used for a variety of purposes. It can be used 
to compress or stretch a recorded bit in order to fit it perfectly into a particular span of 
time. (For example, speed up an 18 second ad so that it fits into a 15 second slot.) It 
can also be used as a special effect to raise or lower the pitch of a recording without 
changing the speed. And it can combine these operations, changing both pitch and time 
simultaneously.

ClipCleaner

Signal Processing and Filtering
The ClipCleaner effect is intended for cleaning and enhancing the quality of noisy 

phone calls, but of course it can be used for other purposes (e.g. special effects) as 
well. ClipCleaner offers a full suite of signal processing tools which may be configured 
independently for each channel.

When you first open ClipCleaner from the Effects menu, the short-form interface 
is displayed, as shown in Figure 4.9. A full range of factory presets is available, and a 
different preset may be selected for each channel. 
Often the studio microphone is already being pro-
cessed in hardware before it is even fed to VoxPro, 
so you might choose to keep the Mic channel on 
Bypass so as not to interfere.   

￼ Figure 4.9 – ClipCleaner short-form dialog.

Use the drop-down combo box to choose a 
preset configuration of DSP settings for that chan-
nel.  The presets beginning with “DJ” are intended 
for the jock’s mic, and the presets beginning with 
“PH” are intended for the caller (phone), but any 
preset may be used in either channel.

Use the Preview button to hear the effect of 
the selected preset(s). Click Commit to write the 
effect to disk and close the dialog.
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Adventurous users may wish to explore the full capabilities of ClipCleaner by opening 
the Full Interface, shown in Figure 4.10.

			   Figure 4.10 – ClipCleaner full interface.

The two buttons in the top left and right corners are used to toggle the display between 
left and right channel settings. Between them are three buttons which enable/disable the 
different processing stages (DeEsser, Dynamics and Parametric Equalizer), as well as 
a menu of Options, including the option to return to the short-form display.￼

Occupying the center of the ClipCleaner interface are the three tab pages with controls 
for the three processing stages. Note that the order in which the processing occurs (the 
signal flow) corresponds to the left-to-right order of the tabs themselves, and that you 
may change the processing order by dragging a tab left or right. The processing order 
may be different for the left and right channels. 

At the bottom of the ClipCleaner window are controls for selecting the preset for each 
channel, as well as controls for saving new presets. Whenever you change any parameter, 
in any of the processing stages, the label above the active channel preset is bookended 
with asterisks (‘*’) to indicate that the current settings differ from the displayed preset.

Let’s now examine each processing stage in detail.

Parametric EQ
There are six filters in the Parametric EQ section, four of which are fully parametric 

(meaning all values may be adjusted), as well as a high-pass filter (HPF) and a low-pass 
filter (LPF). Note that there are six color-coded “control points” (the fuzzy circles with the 
“+” symbol in the middle), one for each filter. The values of the filters can be changed in 
three ways:
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By using the mouse, clicking in a numerical box and typing a value.

By using the mouse and dragging the control point to visually set the EQ.

By using the mouse wheel within a filter control point to adjust filter Q-factor.

High Pass Filter (HPF IN) – When engaged, the HPF reduces frequencies below 
the specified “corner” frequency. This filter can help eliminate rumble and other low 
frequency room noise. Note that the filter’s control point is fixed at the -3dB mark and 
that neither the Q-factor nor the gain may be adjusted.

Low – The first equalizer is labeled LO. This equalizer is shaded on the graph in red.  
There are three options to adjust this control. FREQ sets the center frequency of the 
equalizer. BW (or Q) sets the bandwidth control (or how wide or narrow the adjustment 
will be) and GAIN, which increases or decreases the level of the equalizer.  

Low Shelf – When engaged, the LO SHELF option changes the first equalizer from 
a true parametric to a shelving equalizer. It should be noted that the BW/Q control is 
NOT available if the LO SHELF option is on.

Low-Mid – The second equalizer is labeled LO/MID. This equalizer is shaded on 
the graph in yellow. There are three options to adjust this control. FREQ sets the center 
frequency of the equalizer.  BW (or Q) sets the bandwidth control (or how wide or narrow 
the adjustment will be) and GAIN, which increases or decreases the level of the equalizer.  

High-Mid – The third equalizer is labeled HI/MID. This equalizer is shaded on the 
graph in blue. There are three options to adjust this control. FREQ sets the center fre-
quency of the equalizer. BW (or Q) sets the bandwidth control (or how wide or narrow the 
adjustment will be) and GAIN, which increases or decreases the level of the equalizer.  

High – The fourth equalizer is labeled HI. This equalizer is shaded on the graph in 
purple. There are three options to adjust this control. FREQ sets the center frequency of 
the equalizer. BW (or Q) sets the bandwidth control (or how wide or narrow the adjust-
ment will be) and GAIN, which increases or decreases the level of the equalizer.  

High Shelf – When engaged, the HI SHELF option changes the fourth equalizer 
from a true parametric to a shelving equalizer. It should be noted that the BW/Q control 
is NOT available if the HI SHELF option is on.

Low Pass Filter (LPF IN) – When engaged, the LPF reduces frequencies above the 
specified “corner” frequency. This filter can help eliminate hiss and other high frequency 
noises (such as room noise or telephone line noise) that may show up in a recording.  
Note that the filter’s control point is fixed at the -3dB mark and that neither the Q-factor 
nor the gain may be adjusted.

TIP: When adjusting the equalizers, some users may be more familiar with how 
the BW (bandwidth) control works when the value is changed to the Q factor. You can 
change the value from BW to Q on all four equalizers.  Touching the BW text changes 
the value to Q. To switch back to BW, just tap Q with your mouse.  
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De-Esser
The De-Esser helps to control audio spikes generally above 2KHz that are a result 

of the pronunciation of sibilants such as “S”, “SH”, “CH”, “Z” and sometimes the plosives 
“T” and “D”. It is essentially a frequency-controlled ducker.

Sibilant Filter – This graph and the associated controls 
below set the range of the audio spectrum controlled by the 
De-Esser. You can set the Frequency and Q factor of the 
filter to customize the De-Esser to your needs.

Threshold – Sets the level at which the De-Esser will 
activate. If audio is above the threshold level and in range 
of the Sibilant Filter, the De-Esser will activate.

Attack – Determines how fast the De-Esser will reduce 
audio when it is above the threshold. Faster settings (slider 
to the left) yield more control, but with noticeable operation. 
Slower settings (slider to the right) yield less control and are less 
audible.

Release – Determines how fast the De-Esser will return the gain 
to normal after a correction. Faster settings (slider to the left) may 
sound edgy while maintaining highs. Slower settings (slider to the 
right) may sound smoother with the potential for some high frequency 
loss if set too slow. 

Attenuation – This graph shows the audio level (as indicated 
by the green shaded area) and the amount of gain reduction (as 
indicated by the white line descending from the top of the graph).   

TIP: To set the de-esser parameters, click the Preview button to 
start playback, and use the spectral display to gauge the frequency 
range where the sibilants occur. (You’ll also need to make sure the 
DeEsser is enabled, and you might want to disable Dynamics and 
Param EQ in order to focus on the effect of the de-esser.) The sibi-
lant range will be slightly different for every speaker, and generally 
higher for females than for males. Use the filter Frequency and Q controls to shape 
the filter around this range. (You may also use the mouse to click and drag the filter 
control point right or left to adjust center frequency. Use the mouse wheel to adjust the 
filter’s Q-factor.) Now turn the threshold all the way down, to the left. As you preview 
the effect, you’ll hear that the sibilants are virtually gone. Gradually turn the threshold 
up until you hear the sibilants once again. Use the attack and release settings to fine-
tune how quickly the control signal “kicks in”, and how gradually it releases after the 
sibilant energy dissipates.

Dynamics
The Dynamics section adds expansion, noise gating, compression and limiting to 

your audio. These controls help reduce background noise and level the audio to make 
the volume more consistent.  

Expander

The expander reduces the input gain to a level predetermined by the user when 
no useable audio is present. There are a number of controls to tailor the effect of the 
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expander. To engage the expander, make sure the 
IN box is checked and shaded.

Threshold – The threshold control sets the audio 
level for the expander to engage.  Audio that falls below 
the set value will be subject to expansion.  

TIP: When setting up the Dynamics section, make 
sure the threshold setting for the expander is LOWER 
than the threshold setting for the compressor. A 5dB 
difference between the expander and compressor is a 
good rule of thumb (i.e., if the compressor threshold 
is -25dB, the expander should be -30dB or lower).

Ratio – The ratio control determines how quickly 
the expander will work when audio falls below the 
threshold level. Higher ratios lead to faster (yet more audible) reduction while lower 
ratios work slower but yield a smoother result.

Close – Sets the wait time for the expander to close once audio has fallen below 
the threshold. Longer wait times (slider towards the right) can make the transition to 
expansion less noticeable with the risk of background noise being momentarily amplified.

Open – Sets the wait to for the expander to open once audio is above the threshold.

Noise Gate

The noise gate “turns off” the audio once it falls 
below the user defined threshold.  As a rule of thumb, 
the noise gate threshold should be at least 15-20dB 
lower than the expander threshold set above. If the 
noise gate threshold is set too high (slider to the 
right), risk of undesired audio “dropouts” are possible. 
To activate the noise gate, make sure the IN box is 
checked and shaded.  

Compressor

The compressor is a tried and true audio tool that 
helps minimize the level differences between softer 
sounds and loud sounds. It can add body and punch 
to the audio and improve intelligibility. Unlike a limiter, 
the compressor does allow overshoot but will also 
minimize peaks. There are four tools to help you set 
the compressor for the best results. To engage the 
compressor, make sure the IN box is checked and 
shaded.  

Threshold – The threshold control sets the audio 
level for the compressor to engage. Audio above the 
set value will be subject to compression.  

TIP: When setting up the Dynamics section, com‑
pressor is HIGHER than the threshold setting for the expander. A 5dB difference be-
tween the expander and compressor is a good rule of thumb (i.e., if the compressor 
threshold is -25dB, the expander should be -30dB or lower).
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Ratio – Determines the amount of gain change when audio is above the compres‑
sor threshold. For instance, if your compression ratio is set to 4:1, every 4dB of input 
gain ABOVE the threshold setting will yield only 1dB of output gain after compression. 
With that in mind, you can see how higher ratios will yield a more compressed sound, 
while lower ratios will yield a more natural sound.

Attack – Determines how quickly the compressor will reduce audio once the threshold 
has been met. Lower numbers yield better control at the expense of audible side effects.  
Higher numbers sound better, yet will have less control.  

TIP: For a more natural sound, try matching the delay setting to the compressor 
attack time. This can help keep the audio sounding natural while still maintaining control, 
especially if the attack time is set to higher numbers.  

Release – Determines how fast the compressor will return the gain to normal 
after a correction. Faster settings (slider to the left) may sound edgy and dense if high 
compression ratios and fast attack times are used. Slower settings (slider to the 
right) may sound smoother with the potential for dullness if fast attack times and high 
compression ratios are used.

Limiter

The limiter slider sets the absolute peak value of 
the audio.  Because o the extremely high ratio and fast 
attack time of the limiter, audio peaks are completely 
controlled and not allowed above the set value of the 
limiter. A little bit of limiting is usually not noticeable. 
If you start to hear “pumping” in the audio, you are 
probably too deep into limiting and should move the control to the right until the artifacts 
disappear. To engage the limiter, make sure the IN box is checked and shaded.  

Static Curve

The static curve display shows the transfer function of the raw audio from unpro-
cessed to compressed or limited.  It also indicates the threshold of the noise gate. The 
following images show the static curve display and what various settings 
would look like.

The figure at right shows SOFT KNEE compression with a threshold 
of about -20dB. The red dot indicates the momentary amplitude of 
the audio. Once the audio has reached the -20dB threshold of the 
compressor, the audio is processed and any further amplification is 
stopped. Note the curve has a very smooth transition. This allows the 
audio to have a smooth transition into compression for good level control 
without noticeable compression artifacts.

Compare the SOFT KNEE with this image. Same compressor set-
tings as the image above, but the knee has been changed to HARD 
KNEE and the limiter has been engaged. The crest is no longer a 
curve; instead the audio hits a flat line “brick wall”. Depending on the 
attack and release time settings of the compressor, this type of setup 
can effectively control peaks and still sound quite pleasant.
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The last image has the same compressor and limiter settings as 
the image above, however we have activated the NOISE GATE. When 
the audio signal (as represented by the red dot) falls and reaches the 
noise gate “cliff”, the audio will mute. Care should be taken to set the 
noise gate so that it does not prematurely mute on DESIRED audio.

Knee – The knee control changes the shape of the compressor 
from hard (peak detecting) to medium (peak and average detection) or 
soft (RMS, or average level detecting only). In hard, the audio will have 
a more edgy sound once the compression threshold has been reached. Medium is 
a good setting for most as it evaluates audio on the peak AND average level. The soft 
setting looks at the average level only, sounds smoother but with less level control and 
a tendency to be softer.   

Delay – The delay setting delays the audio with respect to the dynamic envelope 
which is being calculated from the signal itself. For audio that has a lot of peaks and 
dynamic range, setting the delay signal to match the attack time in the compressor 
can yield more accurate results from the compressor algorithm. 

Make Up Gain – If deep gain reduction is performed by the compressor and limiter, 
the make up gain control can compensate for the loss in amplitude on the finished 
product by increasing the output level of the dynamics processor.

Dynamic Envelope

The dynamic envelope displays for the dynamics section 
is similar to the attenuaton graph in the de-esser. This graph 
shows the audio level (as indicated by the green shaded area) 
and the amount of gain reduction (as indicated by the white line 
descending from the top of the graph).   

Stereo Processing

The default processing mode for ClipCleaner is Dual Mono, 
meaning that each channel is processed separately and 
independently of the other (or not processed at all if it is on BYPASS). However, if you 
select the same preset in both channels, then two additional options are available in 
the Options menu.  

Coupled stereo means that both channels are combined to form the level detection 
side-chains in the De-Esser and Dynamics stages. Uncoupled stereo means that the 
two channels are NOT combined for the detection side-chains. However, in either of 
the stereo modes, both the Show Left and Show Right buttons are enabled, and any 
change to any parameter affects both channels equally.
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Chapter 5. Effects (FX) Macros
Effects Macros provide a method by which you can put commonly used ef-

fects on a dedicated button, which can then be applied to the active file in the 
Editor with a mouse click or with the function keys F1-F12. Once you have defined 
at least two macros, you may chain them together in sequence, creating an FX 
Macro Chain. Like single macros, macro chains are assigned to a dedicated 
button which appears in a strip underneath the waveform editor.

As an example, let’s suppose that you commonly perform a particular sequence 
of operations on a phone call after it is recorded: normalize caller, apply favorite 
ClipCleaner preset on caller, run GapBuster (which affects both channels) to 
tighten it up. You could assign each of these individual effects to a macro button, 
and then create an addition button which performs all three in sequence.

Like Hotkeys and tracks in the File List, macro buttons can be color-coded 
according to your own needs. They may also be re-arranged within the macro strip 
by clicking and dragging them to the left or right. Macro buttons may be edited or 
deleted using the right‑click pop-up menu.

There are two ways to create an FX Macro. For “complex” effects (those which 
require a dialog box for their settings and application), the Macro button at the 
bottom of the dialog provides one method, transferring the current effect settings 
to a Macro Creation dialog for that effect. Here you provide additional informa-
tion about your macro: its name, color (optional), which channel(s) and portion 
of the active file it is to be applied to.

The other way to create an FX Macro is to select that command at the very 
top of the Effects menu. Select the effect you want to create a macro for from 
the drop-down list.  Click Next to open the Macro Creation dialog for that effect.

FX Macro Chains are created using the second command at the top of the 
Effects menu. Your existing collection of single macros is listed on the left. Add 
as many single macros to the macro chain as you like by selecting them and click-
ing the right arrow button. The top-to-bottom order of macros in the macro chain 
list determines the sequence in which they will be applied to your file. Provide a 
name and optional color for your macro chain, and you’re done. Like single mac-
ros, macro chains can be edited and deleted using the right-click pop-up menu.

The Undo and Redo commands can be applied to any edit performed by 
means of an FX Macro. A single macro can be undone with a single Undo, while 
undoing a macro chain will require as many taps of the UNDO button as there 
are individual actions in the chain.

FX Macros may also be assigned to the Control Panel soft keys (the five 
buttons under the LCD). For more information, please read the discussion about 
Advanced Shortcuts in Chapter 8.
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Chapter 6. Markers
Markers, or bookmarks, are used to mark locations in your files which have 

special significance for you, so that you may access them quickly and easily at 
a later time. (Do not confuse Markers with the Mark Left /Mark Right operations 
used in selecting an audio region for editing.)

Markers may be inserted at any point into any file by typing the M key on the 
keyboard. (There is currently no way to insert a marker using the control panel.) 
Markers are always inserted into the file at the current position (that is, at the cue 
line). In standby mode, inserting a marker brings up a dialog box which allows you 
to label the marker and assign it a color. The marker is displayed in the Timeline 
track, its position relative to the length of the file as a whole.

Markers may be inserted during recording and playback as well. In these 
cases, the dialog box for the label and color assignment appears, but disappears 
after a few seconds if ignored, leaving a blank marker at the location where the M 
key was initially pressed. (You can always add a label or change the color later 
on.) Alternatively, you may disable the Insert Marker Shows Dialog option (in 
the Markers menu, or by typing <ctrl>M on the keyboard), allowing you to insert 
markers during playback or recording without being prompted to assign a label 
and color for each and every one.  

Markers inserted into a file are displayed in the Markers menu, whence they 
may be edited or deleted. You may also reposition a marker to a precise location 
by using the Go To Marker sub-menu. VoxPro 7.1 jumps to the location of the 
selected marker and displays its position in the file as a fuzzy vertical line through 
the waveform. Click and drag this line left or right to relocate the position of the 
marker, then click the small OK button which pops up to confirm the change. 

Navigating directly from one marker to the next is easy. From the control 
panel, press and hold the OPTION button while using the Fast Forward/Fast 
Rewind buttons to page forward and backwards through the file’s markers. On 
the keyboard, the <page down> and <page up> keys perform the same function.

Marker labels in VoxPro 7.1 now support the Unicode standard, meaning 
that markers may be labeled in any language, using any script (Chinese, Cyrillic, 
Symbols, etc.). However, this standard is not completely compatible with earlier 
versions of VoxPro. VoxPro 7.1 files containing Unicode markers will open cor-
rectly in earlier versions of VoxPro, but the labels will be illegible and essentially 
lost. To maintain compatibility with earlier versions of VoxPro (at the price of being 
able to use only 7-bit ASCII characters in marker labels), unselect the Unicode 
Labels option in the Layout dialog box accessible from the Settings menu.

The Insert-Marker function, as well as the Go-to-Next- and Go-to-Previous-
Marker functions, may also be assigned to Control Panel soft keys (the five but-
tons under the LCD). For more information, please read the discussion about 
Advanced Shortcuts in Chapter 8.
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Chapter 7. Hotkeys

Hotkeys are another way to prepare and organize files for immediate, one-button 
playback. In the Figure 7.1 below, the Hotkeys panel has been opened by clicking on the 
Hotkeys icon (the orange & red bonfire button on the left). If a hardware control panel is 
attached, the active bank of Hotkeys is outlined in gold. The titles to the Hotkeys in the 
active bank are displayed in the control panel LCD, and they can be triggered using the 
corresponding soft key button. The bank scroll buttons in the top left corner of the control 
panel are used to move the active bank up and down. Hotkeys may also be started and 
stopped with a mouse click, or a finger tap if you have a touch-screen.  

Figure 7.1 – Hotkeys panel open in main window, File list moved to the right.

Hotkey Basics
To load a file from the File List into a Hotkey cell, simply click and drag the file from 

the List to the desired Hotkey. VoxPro creates a separate copy of the file and stores it 
in a hidden folder before loading it into the Hotkey. Thus, any change made to the audio 
loaded into a Hotkey cell affects the Hotkey itself and not the original source of the audio. 
Changing attributes and editing Hotkey audio is discussed further below.

To load a file from the File List without changing the active file displayed in the Editor, 
press and hold the <alt> key on the keyboard before clicking and dragging the desired  
file from the List. Files loaded into Hotkeys may be any of length, from less than a second 
to several hours.  

Drag a loaded Hotkey to an empty Hotkey to move the loaded Hotkey. Drag a loaded 
Hotkey to another loaded Hotkey to exchange their positions. Drag a loaded Hotkey up to 
a page tab to open that tab, allowing the file to be moved to any Hotkey cell on that page.

A left-click on an empty Hotkey prompts you immediately to choose a file from any-
where on the local computer or the LAN and load it. 
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A right-click on an empty Hotkey displays a pop-up menu with a full range of import 
options.  For example, you can import the active file (in the Editor) either as a mono mix 
or as a stereo file, and if there is a MultiTrack mix loaded, you may import the entire mix 
or just the title track.  

A left-click on a loaded Hotkey starts the file playing from the beginning. If you click 
again before the file reaches the end, it will fade out, stop and rewind. The next click 
will start it playing from the beginning. Otherwise the file simply plays to the end, then 
rewinds in preparation for the next start.

A right-click on a loaded Hotkey displays a pop-up menu which lets you modify 
various attributes of the cell, and perform various functions. Each Hotkey cell has the 
following attributes:

•	 Pad – for controlling the cell’s playback volume.

•	 Mono-Mix – turns a stereo file into mono during playback.

•	 Allow Pause – stopping the cell does not rewind it, starting it again starts up where 
it was last stopped. Places a small “pause” icon in the top left corner of the cell.  
Use the Rewind function to relocate playback position back to the beginning.

•	 Looped – cell will continue to play in a loop until stopped. Places a “loop” icon in 
the top right corner of the cell.

•	 Fade-Out Time – controls the length of the fade-out applied when the cell is stopped.

•	 Color – choose from a palette of 32 colors for easy visual identification.

Functions include edit, rename, copy, paste, clear, and unload. (Paste is enabled 
only if you have previously copied another Hotkey.)  

The edit function opens the floating Side Editor, shown in Figure 7.2. 

Figure 7.2 – Editing a Hotkeys using floating Side Editor.
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While the Side Editor is open, all keyboard and control panel commands are routed 
to it, rather than to the main window. The Edit and Effects menus in the Side Editor 
replicate most of the same functions familiar from the corresponding menus in the main 
window. Any edit applied to a Hotkey affects that Hotkey only and not the original source 
it was copied or imported from.

There is a distinction between clearing a Hotkey and unloading a Hotkey. Clearing 
a cell resets all attributes in addition to deleting the associated audio file. Unloading a 
cell simply delete the audio file, leaving the other attributes in place. This allows a cell 
to be used as a “socket” into which you may drag or import a different audio file without 
affecting the cell’s attributes (color, pad, fade time, etc).

Hotkey cells are arranged on Tab Pages, of which there are always at least two. To 
add a new Hotkeys tab page, right-click on any existing tab label and select the Add Tab 
command from the pop-up menu. Similarly, you may rename or delete a tab. Clearing 
a tab page unloads and resets all cell attributes on that page. Unloading a tab page 
deletes the audio from all cells on that page, but leaves other attributes as they are. 
Tabs may be alphabetized in order, or they may be manually reordered by clicking 
and dragging any tab left or right.  

Advanced Hotkey Concepts
In Figures  7.1 and 7.2 above, the Hotkeys panel is embedded in the main window, 

forcing the File List to move to the right. The File List may optionally be displayed on the 
left instead, from the Layout dialog in the Settings menu. Using the Views menu, you 
may completely hide both the File List and the Editor, leaving only the Hotkeys panel 
to occupy the entire VoxPro window.  

Additional Hotkeys windows may be opened through the Views menu, or by right-
clicking the Hotkeys icon. You may have as many Hotkeys panels open as you like; they 
can be positioned on any monitor and can be sized arbitrarily, which is very handy for 
multi-monitor configurations. Each Hotkey panel may be open to a different tab page, 
giving you immediate access to potentially hundreds of Hotkeys. You might conversely 
choose to return the main window to “Classic” mode (Editor and File List only), and dis-
play Hotkeys in a separate window on a second monitor. Whatever layout you choose, 
it will be saved and restored the next time you log into your account.  

All Hotkey windows are “instances” of the same “master” Hotkey panel, so, for ex-
ample, if you create a new tab page in one panel it will appear in all of them, if you load 
a cell in one panel you’ll see it in all the other panels, and so on.  

Notice that if you have you have a VoxPro hardware Control Panel and have more 
than one Hotkeys window open, that only one of the Hotkeys panels will be “active” – 
that is, only one will display the gold outline indicating the active bank of cells which can 
be triggered from the soft keys on the Control Panel. (Nonetheless, any Hotkey cell, in 
any window, may be triggered with a mouse click or equivalent finger tap.) To select a 
different Hotkey panel as the “active” one, click anywhere in the gray margin surround-
ing the Hotkeys tab pages in that window.

Several important Hotkey options may be customized in the Hotkeys Settings dialog, 
which can be opened from the Settings menu. Here you can specify how many rows of 
Hotkeys there will be on each tab page (up to a maximum of 12), as well as the preferred 
font size for cell labels.  Here you may also set the default settings for Fade-Out time, 



VoxPro 7.1 / Aug 2018

H O T K E Y S

User Guide – 27

Pad and Mono-Mix. All newly created cells will have these default attributes, and clearing 
a cell will reset these attributes to the selected settings.

 Figure 7.3 – Hotkey settings and default values.

The Hotkey Settings dialog also contains an option for an Exclusive Playback Mode.  
Normally you may play as many Hotkeys as you like, simultaneously and independently.  
To change this behavior, enable the new Hotkey stops current Hotkey option in the 
Playback Options dialog box which is accessible from the Settings menu. When this 
option is enabled, any currently playing Hotkey will stop playing whenever a new Hotkey 
is started.

Hotkey cells may be directed to play out of any audio device on your computer, 
which effectively means that they can be given their own fader on the studio console.  
The Administrator may have already specified a default Hotkeys playback device and 
routed it to a separate fader on the console (see Section 2 of the VoxPro Admin Guide).   
Additional devices may be selected from the Playback Devices menu of a loaded cell’s 
right-click pop-up menu, to allow special routing or processing independent of the main 
audio output.
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Teamwork
Many radio shows are built around, or rely heavily on, pre-prepared audio snippets 

that can be called up at a moment’s notice. VoxPro’s Hotkey feature is designed with this 
job in mind. Built in to the Hotkeys are features that make it easy for production teams 
to work together – so, for example, a producer or call-screener/editor can be seated at 
a computer in a production booth, logged into the air talent’s account, creating Hotkeys; 
while the talent, in the studio, is logged into the same account, is then able to play those 
same Hotkeys. The producer changes the color of a Hotkey cell, the talent sees it. Pro-
ducer adds a new tab page, talent sees it. Any change either party makes to any Hotkey 
or Hotkey Tab Page is immediately visible and accessible to any other user logged into 
the same account on a different computer.   

Nor are you are not limited to just two computers sharing the same remote account. 
Three or more computers, all logged into the same account, is also possible. Note that 
each user, on each computer, can have a different number of Hotkey windows open, 
in different configurations, accessing different tab pages, playing different Hotkeys, all 
independent of one another. Thus a producer might be populating one tab page while 
the on air talent is playing Hotkeys from another page.
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Chapter 8. Advanced Shortcuts

We’ve seen in Chapters 4 and 7 how the five soft keys under the Control Panel’s LCD 
can be used for triggering Hotkeys as well as shortcuts for the most common Effects.  
Starting with VoxPro 7.1, these soft keys may be customized and used in other ways 
as well.

Hold down the Control button on the Control Panel, and you’ll see five Effects shortcuts 
displayed in the LCD. Press the Option button and you’ll see five more functions – a 
few effects, and a few non-effects, like selecting the entire file or toggling Auto-Record.  
Press the Shift button to see a third rank of functions displayed.  

So there are three ranks of five functions each which are available as soft key 
shortcuts. You may customize these functions by using the Shortcuts dialog from the 
Settings menu. Each soft key in each of the three ranks may be assigned any of the 
functions in the associated drop-down list. There are three categories of functions avail-
able: general operations at the top of the list, followed by effects, followed by any FX 
Macros you might have created.

Any of the three ranks of functions may optionally be made active at all times, mean-
ing that these functions are available without having to press the corresponding Control, 
Option or Shift button.   The other ranks are still accessible by pressing their correspond-
ing “escape” button.  
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NOTE: If any of the “Display these functions at all times” options is selected, the soft 
keys cannot be used to trigger audio Hotkeys.

One additional remark should be made concerning soft keys which are assigned to 
Effects and FX Macros. For the Effects, if there is no selected region highlighted in the 
waveform Editor, then activating the soft key shortcut to that Effect will have, well, no 
effect. (Insert-Silence being the one exception to that rule.) However, FX Macros can be 
constructed such that they will apply automatically to the entire file if no region is selected, 
thus they will function exactly like their corresponding on-screen button counterparts  
(see Chapter 5, FX Macros).
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Chapter 9. MultiTrack Editing

Click the MultiTrack button to toggle the Editor into MultiTrack view (Figure 9.1).  The 
active file is now displayed in the top track, also called the title track. The width of the 
display represents the length of the title track from beginning to end. In this example, 
a second support track has been added: a music intro. Note that its position in the 
composite mix precedes the beginning of the title track.  

In the File List, an icon now appears in the left-most column next to the file name; this 
indicates that the file contains MultiTrack content. Even if the Editor is toggled back to the 
normal 2‑track mode, the composite multitrack mix will be played when the file is played.

Figure 9.1 – The Editor in MultiTrack mode. A music intro starts before the main voice track.

To add support tracks, press and hold the <alt> key on the keyboard while dragging a 
file from the File List into the MultiTrack view.  Alternatively, right‑click in any blank area 
of the MultiTrack view to open a file import dialog. You may also drag Hotkeys directly 
into the MultiTrack view.

Click and drag support tracks to the left or right to realign them within the composite 
mix. In this example, the music intro has been dragged to the left, past the beginning of 
the title track, thus inserting an automatic delay before the title track begins to play.

Left‑click any support track to play it by itself. Click again to stop.

Right‑click any support track to display a pop-up menu of options. You may pad the 
track in 1dB increments, you may nudge the track left or right in 50ms increments, you 
may delete the track, and you may edit it in the same manner as Hotkeys, in the floating 
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Side Editor. As with Hotkeys, changes made to support tracks do not affect the original 
files they are derived from.

Individual physical tracks in the MultiTrack view may be muted using the mute switches 
located in the margin to the right of each track. The lock switch to the right of the title 
track locks the entire composition, preventing any inadvertent changes you might make 
without noticing. Note that the mono-mix indicator still appears in the left margin next to 
the title track, and functions identically as in 2-track mode.

If you need more physical tracks for a particular composition, use the Add Support 
Track command in the main Edit menu. If you would like to change the default number 
of physical tracks displayed in MultiTrack view, change the Support Tracks value in the 
Layout dialog box accessible from the Settings menu.

A MultiTrack mix may be bounced to a single file by using the Render Multitrack Mix 
command in the File menu. The file is given the same name as the title track (appended 
with “mix”) and appears in the File List next to the original.

A MultiTrack mix may also be exported using the normal Export command in the 
File menu. Support tracks will be included in the mix if this option is selected in the 
Export dialog box.

If the Hotkeys panel is open, then the MultiTrack mix may also be imported directly 
into any Hotkey using the right-click pop-up menu of the Hotkey itself.



VoxPro 7.1 / Aug 2018

I M P O R T  A N D  E X P O R T

User Guide – 33

Chapter 10. Import and Export
You may import audio files (MP3s, Waves, etc) created outside of VoxPro using 

the Import command in the main File menu. If you discover a file format which cannot 
be imported, contact your system administrator and ask for the Combined Commu-
nity Codec Pack to be installed. This is a set of freely available codecs which provide 
Windows with the native ability to import many different file types. You can find a link to 
the CCCPack on the Wheatstone website.

Use the Import in Background command in the File menu if you have many long files 
to import and you need to continue working in VoxPro7 while the import process takes 
place. This can take an especially long time if a format conversion is required in order 
to render the file correctly using VoxPro 7.1’s default sample rate. (See the VoxPro7.1 
Admin Guide for details on audio device and format settings.)

Auto-Import is a feature which automatically imports audio files which appear in a 
specified folder on your local computer or on the LAN. Configure and enable Auto-Import 
from the Import & Auto-Import dialog available from the Settings menu, specifying both 
the source folder which VoxPro7 is to montor, as well as your own destination folder into 
which the files will be copied. Use a UNC path for the source folder if you will be using 
the Auto-Import feature from remote VoxPro workstations.

Files imported using the Auto-Import function may also be automatically processed, 
allowing volume to be adjusted either an absolute amount or a relative amount via 
normalization.  Optionally, the left or right channel may be muted.  These functions are 
available by clicking the Additional Audio Processing button in the Import & Auto-
Import Settings dialog.

You may export files to Wave or MP3 format using the Export command in the main 
File menu. Note that you have a range of choices in how to export the file, including 
swapping channels, condensing to a mono mix, leaving out one channel, etc. You may 
export a file to any folder on your local computer or on the LAN.

EZ-Export is a useful feature if you find yourself continually exporting files to a par-
ticular destination and in a particular format. Configure EZ-Export from the Settings 
menu. You specify a destination folder as well as a format. Henceforth, you can export 
any selected file to that location with one mouse click, either by using the EZ-Export 
command in the main File menu, or by right-clicking the file in the File List.

You may use the Archive command in the File menu to copy the selected file(s) to 
a backup location on your LAN. This is different from exporting because the actual VPW 
file that VoxPro7 uses is copied, thus maintaining the entire edit history.
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Chapter 11. Files and Folders
Every VoxPro user account comes with three standard folders in which files are (or 

may be) stored.  These are the Default folder, where you’ll be working unless you specify 
otherwise; the Transfer folder, which is your “in-box”, the place where files appear which 
are sent to you by other users; and the Deleted Files folder, which is where cancelled 
recordings and deleted files go until you really, truly, irrevocably delete them. 

To create additional folders use the Add Folder command in the Folders menu.  Use 
the same menu to switch between folders, and to delete and rename folders.

Right-click on any file in the File List to bring up a menu with options for various 
commands related to the file as a whole. The Copy command creates a copy of the file 
within the same folder. The Copy To command lets you make a copy of the file to any of 
your other folders, or to any other VoxPro user on the local computer or the LAN. Files 
copied to other users appear in the Transfer folder of that user. The Move command 
can be used to move the file to any of your other folders. The Delete command simply 
moves the file to your Deleted Files folder. Delete, Export, EZ-Export, Rename and 
New Edit from Selection are convenience commands which are also found in the main 
File menu. The Color command allows you to apply a highlighter-like color behind the 
file’s name and length, as a convenient visual reference.

VoxPro uses a semi-proprietary file format called VoxPro Wave, or VPW. The VPW 
format is identical to the standard RIFF Wave format, except for the inclusion of an 
additional RIFF chunk in which VoxPro stores information about the edits (changes) 
you’ve made to the file. In extraordinary circumstances (for example if something in the 
file get corrupted and VoxPro is unable to open it as a VPW file), then you can change 
the extension on the filename from “.vpw” to “.wav” and then import it as a standard Wave 
file. Note that this has the effect of ignoring all edits that might have been made to the 
file: you are, in effect, returning the file to its original state.

At times you or a co-worker may use Windows File Explorer or a similar utility to delete 
files from one of your folders, or to add files from elsewhere, without going through the 
“proper channels” within VoxPro. In these cases, the database that VoxPro maintains for 
that folder will be out of sync with the actual contents of the folder. Thus, for example, 
a file which appears in the File List might not actually be on the disk, or a file which is 
physically present in the folder might nonetheless not appear in the File List. To resolve 
these conflicts, use the Rebuild File Database command in the main File menu to re-
synchronize the database for the current folder.   

Keep in mind that the more files there are in a folder, the more time required to list 
them and to maintain a coherent database. We recommend around 2000 files per folder 
as a good working limit. More than that and you’ll probably start to notice how much 
longer it’s taking to log in, or to switch to that folder. We have seen one user with over 
12,000 files in one folder, however, so the actual limit is probably quite high.  

You may use the Search command in the File menu (or type <ctrl>S on the key-
board) to locate files within your own folders as well as other users’ folders. The Search 
function also lists Hotkeys which match the search parameters. Files for which you do 
not have write permission are highlighted in light red.. Otherwise, you may copy, move, 
delete, rename or edit any file returned in the list. Double-click any file in the list to play 
it. Additionally, the QuikSearch panel at the top right corner of the file list (in Classic 
mode) lets you quickly search through the current folder for files containing the sequence 
of characters you type in.
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Chapter 12. Miscellaneous Settings
Meters

Several options pertaining to the location and operation of the peak program meters 
are available in the Meters dialog box in the Settings menu. The meter style (LED or 
continuous) and dynamic range can be customized, as well as an option to deactivate 
meters when not playing or recording. The meters may be displayed vertically, to the right 
of the File List (the default, classic arrangement); or horizontally, beneath the waveform 
display in the Editor.

Touch Controls
An option to display on-screen touch controls for Play/Stop/Record/Scrub functions 

is available in the Layout dialog box in the Settings menu. These controls are intended 
for operation on tablets and other touch-screen devices where other options for basic 
control are limited.

Font Size
The size of the font used in the File List and on Hotkeys may be increased or de-

creased from within the Layout dialog box in the Settings menu.

Password
You may password-protect your VoxPro user account by assigning a password using 

the Change Password dialog box in the Settings menu.  

VoxPro Control Panel
Normally there is only one hardware control panel attached to the computer, but 

you may actually connect up to four controllers to a single VoxPro computer – useful in 
situations where two or more team members run a show sharing a single computer with 
multiple monitors.  

If the control panel appears not to be functioning (but the software itself is), open the 
Control Panel dialog box in the Settings menu. If a control panel is present, the option 
to use the control panel should be checked. Check the serial control panel attached 
option only if there is a serial (RS-232) controller connected to a COM port. (These are 
increasingly rare on modern computers.) If closing the dialog box using the Reset and 
Close option does not revive the connection, try it again using the Cycle Ports option. 
Allow a couple of seconds after this maneuver for the connection to the control panel 
to be re-established. If the controller is still unable to connect, contact your VoxPro ad-
ministrator.

The Control Panel dialog box also provides two options to reassign certain buttons 
on the controller so that they perform different functions. These options are intended 
for an older version of the control panel called the RC-400, which had a different button 
layout than the current RC-500 control panel.

Disable Remote Control
If your administrator has enabled remote control functions of any sort, you may disable 

them from the Remote Control dialog box in the Settings menu. There are separate 
options to disable contact closures detected at the control panel’s D-sub (DB-9) port, 
and to disable software logic signals, both incoming and outgoing.
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Appendix 1. Control Panel Button Combos
The buttons on the control panel are for the most part well marked except for the 

Bank Select buttons, which are primarily used to change the active Hotkey bank, and 
the List Scroll buttons which provide the primary means of scrolling through the File List.

Several of the buttons on the control panel perform special functions when used in 
combination.

Fast Scrub buttons

•	 with Shift: cycle through tab pages in Hotkeys Panel

•	 with Option: go to next/previous Marker.

Bank Select buttons

•	 with Shift: cycle through tab pages in Hotkeys panel.

Control button

•	 press and hold to display Effects shortcuts in LCD (only with selected region in 
Editor).

Undo button

•	 with Option: Redo.
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Zoom button

•	 with Control: set waveform display to maximum zoom.

Go To Beginning button

•	 with Option: Go to End  (used on older control panel models).

Go To End button

•	 with Option: Go to Beginning  (used on older control panel models).
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Appendix 2. Keyboard Shortcuts

KEY FUNCTION FUNCTION WITH CONTROL KEY

A Select entire file (All) Select entire file (All)
B Bleep selected region Bleep selected region
C Copy selected region Copy selected region
D Delete selected file(s)
E Export selected file(s)
F EZ-Export selected file(s)
G Apply GapBuster Open GapBuster dialog
H
I Insert-Record Import
J
K Deselect Deselect
L Logout
M Insert Marker Toggle Insert-Marker-Shows-Dialog
N New Empty File
O Toggle mono-mix playback Normalize selected region
P Play from beginning
Q Cycle through zoom Maximum zoom
R Record Rename active file
S Play selected region Open Search dialog
T Empty deleted files folder (Trash)
U
V Paste selection Paste selection
W Toggle Master mode Toggle Master mode
X Cut selection Cut selection
Y Redo Redo
Z Undo Undo

[ Mark Left (selection region)
] Mark Right (selection region)
>  (.) Fade out selected region
<  (,) Fade in selected region
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KEY FUNCTION FUNCTION WITH CONTROL KEY
Escape Cancel (recording or dialog box)
Home Go to beginning of active file
End Go to end of active file
Page Up Go to previous Marker
Page Down Go to next Marker
Delete Delete selected region
Left Arrow Fast forward Slow forward (normal with shift key)
Right Arrow Fast reverse Slow reverse (normal with shift key)
Up Arrow Scroll up in File List
Down Arrow Scroll down in File List
Backspace Delete Selected Region
Space Play from cue, stop
Enter Play from cue, stop

These key shortcuts are available from the number pad (numpad), with NumLock 
engaged:

9 Fast forward
8 Fast reverse
6 Normal speed forward
5 Normal speed reverse
3 Slow speed forward
2 Slow speed reverse
/ Mark Left (selected region)
* Mark Right (selected region)
- Go to end / Go to beginning
+ Record
Enter Play from cue, stop
. Delete selected region
7 Play from beginning
4 Play selected region
1 Cancel
0 Insert-Record
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